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NI-IMAQ	for	IEEE	1394	Cameras	gives	you	the	ability	to	acquire	images
with	industrial	IEEE	1394	digital	video	cameras.	The	cameras	may
operate	at	various	resolutions	and	frame	rates,	depending	on	camera
capabilities.	NI-IMAQ	for	IEEE	1394	Cameras	works	with	the	LabVIEW
Real-Time	Module	7.0	and	later,	and	Windows	XP/2000.
This	help	file	explains	how	to	configure	the	NI-IMAQ	for	IEEE	1394
Cameras	driver	software	and	IEEE	1394	cameras	using	Measurement	&
Automation	Explorer	(MAX).	You	can	use	MAX	to	perform	the	following
operations:

Configure	the	device	attributes
Display	a	histogram	to	help	configure	the	device
Perform	snap	and	grab	image	acquisitions	for	diagnostics	and
verification
Save	acquired	images	as	bitmap	(BMP),	tagged	image	file	(TIFF),
or	Portable	Network	Graphic	(PNG)	files

To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window.
For	more	information	about	this	help	file,	refer	to	the	following	topics:
Conventions—formatting	and	typographical	conventions	in	this	help	file
Important	Information
Technical	Support	and	Professional	Services
To	comment	on	National	Instruments	documentation,	refer	to	the	National
Instruments	Web	site.
©	2001–2005	National	Instruments	Corporation.	All	rights	reserved.
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Conventions
This	help	file	uses	the	following	conventions:
» The	»	symbol	leads	you	through	nested	menu	items	and	dialog	box	options	to	a	final	action.

The	sequence	File»Page	Setup»Options	directs	you	to	pull	down	the	File	menu,	select	the
Page	Setup	item,	and	select	Options	from	the	last	dialog	box.
This	icon	denotes	a	tip,	which	alerts	you	to	advisory	information.

This	icon	denotes	a	note,	which	alerts	you	to	important	information.

bold Bold	text	denotes	items	that	you	must	select	or	click	on	in	the	software,	such	as	menu	items
and	dialog	box	options.	Bold	text	also	denotes	parameter	names,	emphasis,	or	an
introduction	to	a	key	concept.

green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables	or	cross	references.	This	font	also	denotes	text	that	is	a
placeholder	for	a	word	or	value	that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should	enter	from	the	keyboard,	sections
of	code,	programming	examples,	and	syntax	examples.	This	font	is	also	used	for	the	proper
names	of	disk	drives,	paths,	directories,	programs,	subprograms,	subroutines,	device
names,	functions,	operations,	variables,	filenames,	and	extensions.



Connecting	the	IEEE	1394	Camera
You	can	connect	an	IEEE	1394	camera	to	a	local	Windows	machine	or	a
LabVIEW	Real-Time	(RT)	target	machine.

Note		Before	you	connect	a	camera,	make	sure	the	IEEE	1394	hardware	and	NI-IMAQ	for
IEEE	1394	Cameras	software	is	installed.



Local	Connection
Complete	the	following	steps	to	connect	the	camera	to	a	local	Windows
machine:

1.	 Connect	the	camera	to	the	IEEE	1394	port	on	the	local	machine.
2.	 In	the	MAX	configuration	tree,	expand	Devices	and	Interfaces	to

obtain	a	list	of	installed	devices.
3.	 Expand	NI-IMAQ	IEEE	1394	Devices	to	obtain	a	list	of	available

cameras.
4.	 If	the	camera	fails	to	initialize	as	an	NI-IMAQ	IEEE	1394	digital

camera,	a	warning	dialog	box	opens,	and	a	red	circle	with	a	white
X	appears	next	to	the	camera.	To	configure	the	camera	as	an	NI-
IMAQ	IEEE	1394	digital	camera,	right-click	the	camera	and	select
Driver»NI-IMAQ	IEEE	1394	IIDC	Digital	Camera.

5.	 Select	the	appropriate	camera	from	the	list.



Remote	Connection
Complete	the	following	steps	to	connect	the	camera	to	a	LabVIEW	RT
target	machine:

1.	 Connect	the	camera	to	the	IEEE	1394	port	on	the	RT	target
machine.

2.	 In	the	MAX	configuration	tree,	expand	Remote	Systems.	A	short
delay	occurs	while	MAX	locates	all	the	remote	devices.

3.	 Expand	the	remote	device	you	want	to	target.	If	the	device	is	not
configured,	refer	to	the	MAX	Remote	Systems	Help	topics
(Help»MAX	Help)	for	information	about	adding	a	remote	device.

4.	 Expand	Software.	Confirm	that	the	NI-IMAQ	for	IEEE	1394	RT
software	is	installed	on	the	remote	device.

5.	 If	the	NI-IMAQ	for	IEEE	1394	RT	software	is	not	installed,
complete	the	following	steps	to	install	the	software:

a.	 Click	Software.
b.	 Click	Install	Software	on	the	MAX	toolbar	to	launch	the

LabVIEW	Real-Time	Install	Wizard.
c.	 Select	NI-IMAQ	for	IEEE	1394	RT,	as	well	as	any

additional	software	you	would	like	to	install	on	the	target
machine.

d.	 Click	Next.	Review	the	list	of	software	you	selected	to
install.

e.	 Click	Next	to	begin	downloading	the	software	to	the	target
machine.	When	MAX	has	finished	downloading	the
software,	it	restarts	the	remote	device.

f.	 Click	Finish.
g.	 Press	<F5>	to	refresh	the	MAX	configuration	tree.	Your

IEEE	1394	camera	should	be	listed	under	the	Remote
Systems	branch.

6.	 Expand	Devices	and	Interfaces.
7.	 Expand	NI-IMAQ	IEEE	1394	Devices	to	obtain	a	list	of	available

cameras.	If	the	IMAQ	IEEE	1394	Devices	folder	is	not	present,
the	NI-IMAQ	for	IEEE	1394	Cameras	software	failed	to	initialize.



8.	 Select	the	appropriate	camera	from	the	list.
Note		When	you	connect	a	new	device	to	a	local	or	remote	system,	press	<F5>	to	refresh	the
configuration	tree	and	update	the	list	of	cameras	in	the	NI-IMAQ	IEEE	1394	Devices	folder.



Configuring	the	IEEE	1394	Camera
When	the	camera	is	successfully	connected,	you	can	configure	the
camera	in	MAX	to	perform	acquisitions.
Complete	the	following	steps	to	configure	the	IEEE	1394	camera	for	a
snap	acquisition:

1.	 Connect	the	camera	to	the	IEEE	1394	port	on	the	computer.
2.	 In	the	MAX	configuration	tree,	expand	Devices	and	Interfaces	to

obtain	a	list	of	installed	devices.
3.	 Expand	NI-IMAQ	IEEE	1394	Devices	to	obtain	a	list	of	available

cameras.
4.	 Click	the	camera	name	to	select	the	appropriate	camera.
5.	 Click	Snap	to	acquire	a	single	image.

Tip		Click	Grab	to	acquire	images	continuously	while
focusing	the	camera.	Click	Grab	again	to	stop	the
acquisition.

6.	 Use	the	Acquisition	Parameters	and	Camera	Attributes	tabs	to
modify	the	camera	video	parameters.

7.	 Click	Snap	after	adjusting	the	parameters	to	view	how	these
changes	affect	the	image.

8.	 Click	Save	to	save	the	current	configuration.	These	settings
become	the	default	settings	for	the	camera.



Setting	Remote	Image	Options
When	performing	a	snap	or	grab	from	a	remote	system,	images	are
transferred	across	the	network	and	displayed	on	your	local	machine.
Complete	the	following	steps	to	balance	network	performance	and	image
quality.

1.	 Select	Tools»IMAQ»Remote	Image	Options.
2.	 Select	Transfer	images	from	remote	target	to	local	host.
3.	 Select	Compress	images	before	transfer.
4.	 Adjust	the	image	quality	slider	as	shown	in	the	following	figure.

5.	 Select	Display	images	on	remote	monitor.
6.	 Set	Timeout	to	60,000	ms.



Transfer
Select	the	Transfer	images	from	remote	target	to	local	host	checkbox
to	display	images	in	the	MAX	window.	Clear	the	checkbox	to	disable
image	transfer.	Select	the	Compress	images	before	transfer	checkbox
to	perform	lossy	JPEG	compression.	Adjust	the	quality	slider	to	set	the
JPEG	compression	rate.	Higher	quality	images	take	longer	to	transfer.
This	option	is	useful	if	you	are	unable	to	transfer	images	at	full	frame
rate.	Clear	the	checkbox	to	transfer	images	without	compression.	The
default	settings	are	Transfer	selected,	Compress	selected,	and	moderate
compression.

Note		Changes	to	the	default	compression	and	image	quality	settings	remain	on	the	remote
target	until	you	reboot	the	target	or	programmatically	change	the	settings.



Display
Select	the	Display	images	on	remote	monitor	checkbox	to	display	the
image	on	the	remote	video	controller	in	the	default	video	mode.	Ensure
that	a	video	monitor	is	connected	the	remote	system.	Clear	the	checkbox
to	disable	the	display	on	the	remote	monitor.	By	default,	the	Display
checkbox	is	selected.

Note		Currently,	the	video	display	supports	only	Intel	i815	and	i845	graphics	chipsets.



Timeout
Specify	the	amount	of	time	for	the	local	host	to	wait	for	an	image	from	the
remote	target.	This	timeout	applies	only	to	transfers	from	the	remote
target	to	the	local	host.	The	default	is	60,000	ms,	or	1	minute.



Toolbar
The	toolbar	contains	the	following	buttons:

Save	commits	all	of	the	camera	configuration	parameters	and
stores	the	information	on	the	system	to	which	the	camera	is
connected.	This	button	is	disabled	if	none	of	the	parameters	have
changed.
Revert	returns	all	parameters	to	the	values	before	the	last	time
you	clicked	Save.

Note		The	Save	Changes?	dialog	box	opens	if	you	attempt
to	close	MAX	without	saving	the	parameter	changes.	If	you
do	not	save	the	changes,	the	camera	will	not	be	configured
as	expected.

Snap	performs	a	single-buffer,	single-shot	acquisition	and	displays
the	result	in	the	image	viewer.
Grab	performs	a	multiple-buffer,	continuous	acquisition	and
updates	the	image	viewer.	Click	Grab	again	to	stop	the	continuous
acquisition.

Note		Snap	and	Grab	use	the	latest	parameters	to	perform
an	acquisition,	allowing	you	to	preview	parameter	changes
before	saving	them	to	the	camera	file.

Histogram	displays	a	quantitative	distribution	of	the	pixels	in	the
most	recently	acquired	image	per	gray-level	value.	During	a
continuous	acquisition,	the	histogram	continuously	updates.
Save	Image	writes	the	most	recently	acquired	image	to	a	user-
specified	location.
Show/Hide	Help	displays/hides	the	topic	and	context	sensitive
help	to	the	right	of	the	image	viewer.



Camera	Properties
General	Tab
Acquisition	Parameters	Tab
Camera	Attributes	Tab
Bayer	Color	Tab



General	Tab
View	camera	properties	from	the	General	tab.	This	information	is	also
reflected	in	the	MAX	configuration	tree.

Name	is	the	interface	name	used	to	open	the	camera	through	the
programming	interface.	Interface	names	are	assigned	by	the
driver.	The	first	attached	device	is	assigned	cam0.	Subsequent
devices	are	named	cam1,	cam2,	and	so	on.
Vendor	is	the	name	of	the	camera	manufacturer.
Model	is	the	model	name	of	the	camera.
Serial	Number	is	the	64-bit	unique	ID	of	the	camera.



Acquisition	Parameters	Tab
Change	video	acquisition	parameters	from	the	Acquisition	Parameters
tab.

Video	Mode	displays	a	list	of	all	available	video	modes	for	the
camera.	Select	the	appropriate	video	mode.	If	you	select	Format	7,
you	also	must	set	the	Color	Coding	mode.
Color	Coding	displays	a	list	of	available	color	coding	modes	for
the	camera	in	Partial	Image	Format	(Format	7)	mode.	For	non-
Format	7	modes,	this	parameter	returns	the	default	color	coding	for
the	camera.	Refer	to	the	camera	documentation	for	the	appropriate
color	coding.
Speed	displays	a	list	of	available	transfer	speeds	for	the	camera.
The	default	is	400	Mbps.
Region	of	Interest	controls	the	acquisition	window	of	the	camera.
The	four	parameters	are	Left,	Top,	Width,	and	Height.	For	Format
7	mode,	these	parameters	affect	the	amount	of	data	sent	across
the	IEEE	1394	bus.	For	non-Format	7	modes,	these	parameters
affect	the	amount	of	data	decoded	by	the	driver.
Timeout	sets	the	number	of	milliseconds	the	driver	waits	for	the
acquisition	to	complete	before	returning	a	timeout	error.	The
default	is	5,000	ms.
Packet	Size	specifies	the	number	of	bytes	transferred	in	each	data
packet.	Changes	to	this	parameter	affect	the	number	of	packets
required	to	transmit	an	image	over	the	IEEE	1394	bus.	Larger
values	transfer	images	faster.	Smaller	values	allow	more	cameras
to	coexist	on	the	same	bus.
Ignore	First	Frame	pauses	for	a	frame	interval	before	returning	an
image.	Set	this	option	if	a	snap	acquisition	returns	an	incorrectly
exposed	image.
Actual	Bit	Depth	specifies	the	number	of	bits	per	pixel	that
contain	image	information.	This	parameter	applies	only	to	images
with	16-bit	components.
Bit	Alignment	specifies	the	alignment	of	pixel	information	in
memory.	Refer	to	the	camera	specifications	for	the	correct
alignment.	The	default	is	Least	Significant	Bit	(LSB).	This



parameter	applies	only	to	images	with	16-bit	components.
Byte	Order	specifies	the	order	in	which	multibyte	data	is	stored.
Refer	to	your	camera	specifications	for	the	correct	byte	order.	The
default	is	Big	Endian.	This	parameter	applies	only	to	images	with
16-bit	components.



Camera	Attributes	Tab
View	and	modify	camera	attributes	from	the	Camera	Attributes	tab.
Select	a	feature,	and	use	the	slider	or	textbox	to	view	and	modify	the
attribute	value.
Use	Auto	to	allow	the	camera	to	always	control	a	feature.
Use	One	Push	to	allow	the	camera	to	control	a	feature	once	and	then
return	to	the	manual	control	state	with	adjusted	values.
Use	Off	to	disable	the	selected	feature.
Use	Manual	(Absolute)	to	set	the	selected	feature	to	use	32-bit	floating-
point	numbers	that	map	to	real-world	units.
Use	Manual	(Relative)	to	set	the	selected	feature	to	use	12-bit	integers
that	do	not	map	to	real-world	units.
Use	Ignore	to	prevent	the	driver	from	writing	any	values	for	the	selected
feature	to	the	camera.
The	feature	set	of	the	camera	is	defined	by	the	manufacturer	and	can
include	the	following	features:

Auto-Exposure	performs	a	single	acquisition	and	calculates	the
optimum	white	and	black	reference	levels	based	on	the	dynamic
range	of	the	image.
Brightness	adjusts	the	black	level	of	the	acquired	image.
Focus	controls	the	lens	focus	for	the	camera.
Gain	controls	the	intensity	of	the	image.
Gamma	adjusts	the	gamma	of	an	acquired	image.	Gamma	is	a
nonlinear	change	in	the	difference	between	the	video	signal
brightness	level	and	the	voltage	level	needed	to	produce	that
brightness.
Hue	adjusts	the	color	phase	of	the	acquired	image.
Iris	controls	the	iris	of	a	mechanical	lens.	Adjust	this	value	to
increase	or	decrease	the	amount	of	light	that	passes	through	the
camera	lens.
Optical	Filter	changes	the	optical	filter	of	the	camera	lens
function.



Pan	controls	the	horizontal	movement	of	the	camera.
Saturation	adjusts	the	richness	of	the	color.	A	saturation	of	zero
corresponds	to	no	color,	or	a	gray	pixel.	For	example,	pink	is	red
with	low	saturation.
Sharpness	adjusts	the	sharpness	of	the	picture.	Increasing
sharpness	produces	better-defined	edges	in	the	image.
Shutter	Speed	adjusts	the	integration	time	of	the	camera	sensor.
Integration	time	is	the	duration	per	frame	that	the	sensor	is
exposed	to	light.
Temperature	gets	the	temperature	inside	the	camera	or	controls
the	temperature.
Tilt	controls	the	vertical	movement	of	the	camera.
White	Balance	adjusts	the	white	color	of	the	image	along	the	U
(blue)	and	V	(red)	color	planes.
Zoom	controls	the	lens	magnification	for	cameras	with	a	motorized
lens.
Trigger	Delay	sets	the	delay	between	the	incoming	external
trigger	and	the	start	of	frame	exposure.
White	Shading	Compensation	adjusts	the	white	shading
compensation.
Frame	Rate	Prioritize	sets	the	frame	rate	priority	within	the
current	video	mode.	This	attribute	corresponds	to	an	absolute
value	in	frames/s.

Reset	to	Defaults	resets	all	camera	attributes	to	the	manufacturer
default	values.



Bayer	Color	Tab
Change	Bayer	color	parameters	from	the	Bayer	Color	tab.

Bayer	Pattern	sets	the	variation	of	the	Bayer	encoder	pattern
used	to	encode	the	image.
Red	Gain	adjusts	the	red	gain	of	the	RGB	image.	The	default	is
1.000.
Green	Gain	adjusts	the	green	gain	of	the	RGB	image.	The	default
is	1.000.
Blue	Gain	adjusts	the	blue	gain	of	the	RGB	image.	The	default	is
1.000.
White	Level	sets	the	white	level	to	optimize	the	input	signal	range.
Monitor	the	image	histogram	to	choose	the	appropriate	white	offset
level.	The	white	level	is	programmable	in	the	range	of	0	to	255.
Higher	values	produce	brighter	images.	The	default	is	220.
Auto	Calculate	Gains	calculates	the	values	for	Red,	Green,	and
Blue	Gain.	Complete	the	following	steps	to	calculate	the
appropriate	gains:

1.	 Set	White	Level	to	the	desired	value.
2.	 Point	the	camera	at	a	predominately	white	object,	such	as	a

sheet	of	paper.
3.	 Click	Auto	Calculate	Gains.



Important	Information
Warranty
Copyright
Trademarks
Patents
Warning	Regarding	Use	of	NI	Products



Warranty
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
Except	as	specified	herein,	National	Instruments	makes	no
warranties,	express	or	implied,	and	specifically	disclaims	any
warranty	of	merchantability	or	fitness	for	a	particular	purpose.
Customer's	right	to	recover	damages	caused	by	fault	or	negligence
on	the	part	of	National	Instruments	shall	be	limited	to	the	amount
theretofore	paid	by	the	customer.	National	Instruments	will	not	be
liable	for	damages	resulting	from	loss	of	data,	profits,	use	of
products,	or	incidental	or	consequential	damages,	even	if	advised
of	the	possibility	thereof.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in
contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action



accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.

javascript:WWW(WWW_Trademark)


Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file	on
your	CD,	or	ni.com/patents.

javascript:WWW(WWW_Patents)


WARNING	REGARDING	USE	OF	NATIONAL	INSTRUMENTS
PRODUCTS
(1)	National	Instruments	products	are	not	designed	with
components	and	testing	for	a	level	of	reliability	suitable	for	use	in	or
in	connection	with	surgical	implants	or	as	critical	components	in
any	life	support	systems	whose	failure	to	perform	can	reasonably
be	expected	to	cause	significant	injury	to	a	human.
(2)	In	any	application,	including	the	above,	reliability	of	operation	of
the	software	products	can	be	impaired	by	adverse	factors,	including
but	not	limited	to	fluctuations	in	electrical	power	supply,	computer
hardware	malfunctions,	computer	operating	system	software
fitness,	fitness	of	compilers	and	development	software	used	to
develop	an	application,	installation	errors,	software	and	hardware
compatibility	problems,	malfunctions	or	failures	of	electronic
monitoring	or	control	devices,	transient	failures	of	electronic
systems	(hardware	and/or	software),	unanticipated	uses	or
misuses,	or	errors	on	the	part	of	the	user	or	applications	designer
(adverse	factors	such	as	these	are	hereafter	collectively	termed
"system	failures").	Any	application	where	a	system	failure	would
create	a	risk	of	harm	to	property	or	persons	(including	the	risk	of
bodily	injury	and	death)	should	not	be	reliant	solely	upon	one	form
of	electronic	system	due	to	the	risk	of	system	failure.	To	avoid
damage,	injury,	or	death,	the	user	or	application	designer	must	take
reasonably	prudent	steps	to	protect	against	system	failures,
including	but	not	limited	to	back-up	or	shut	down	mechanisms.
Because	each	end-user	system	is	customized	and	differs	from
National	Instruments'	testing	platforms	and	because	a	user	or
application	designer	may	use	National	Instruments	products	in
combination	with	other	products	in	a	manner	not	evaluated	or
contemplated	by	National	Instruments,	the	user	or	application
designer	is	ultimately	responsible	for	verifying	and	validating	the
suitability	of	National	Instruments	products	whenever	National
Instruments	products	are	incorporated	in	a	system	or	application,
including,	without	limitation,	the	appropriate	design,	process	and
safety	level	of	such	system	or	application.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site	at	ni.com
for	technical	support	and	professional	services:

Support—Online	technical	support	resources	at	ni.com/support
include	the	following:

Self-Help	Resources—For	answers	and	solutions,	visit	the
award-winning	National	Instruments	Web	site	for	software
drivers	and	updates,	a	searchable	KnowledgeBase,	product
manuals,	step-by-step	troubleshooting	wizards,	thousands	of
example	programs,	tutorials,	application	notes,	instrument
drivers,	and	so	on.
Free	Technical	Support—All	registered	users	receive	free
Basic	Service,	which	includes	access	to	hundreds	of
Applications	Engineers	worldwide	in	the	NI	Developer
Exchange	at	ni.com/exchange.	National	Instruments
Applications	Engineers	make	sure	every	question	receives
an	answer.
For	information	about	other	technical	support	options	in	your
area,	visit	ni.com/services	or	contact	your	local	office	at
ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800

Austria 43	0	662	45	79	90	0

Belgium 32	0	2	757	00	20

Brazil 55	11	3262	3599

Canada 800	433	3488

China 86	21	6555	7838

Czech	Republic 420	224	235	774

Denmark 45	45	76	26	00

Finland 385	0	9	725	725	11

France 33	0	1	48	14	24	24

Germany 49	0	89	741	31	30

India 91	80	51190000

Israel 972	0	3	6393737

Italy 39	02	413091

Japan 81	3	5472	2970

Korea 82	02	3451	3400

Lebanon 961	0	1	33	28	28

Malaysia 1800	887710

Mexico 01	800	010	0793

Netherlands 31	0	348	433	466

New	Zealand 0800	553	322

Norway 47	0	66	90	76	60

Poland 48	22	3390150

Portugal 351	210	311	210

Russia 7	095	783	68	51

Singapore 1800	226	5886

Slovenia 386	3	425	4200

South	Africa 27	0	11	805	8197

Spain 34	91	640	0085

Sweden 46	0	8	587	895	00

Switzerland 41	56	200	51	51

Taiwan 886	02	2377	2222

Thailand 662	992	7519

United	Kingdom 44	0	1635	523545

United	States	(Corporate) 512	683	0100
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